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1 Introduction 
 

 

1.1 Overview of the Solidus eCare Application 
Suite 

 
Welcome to the Solidus eCare application suite. 

 
The Solidus eCare application suite is made up of nine core 
applications. These core applications are divided into three 
fundamental categories: 

 
Agent Applications 

 
The modules in this category are the focal point of the customer interaction 
center and therefore constitute our most extensive category. 

 

 

1.1.1 Desktop Manager 

 

  Desktop Manager Standard – provides agents access to voice/call related 
features including call control capabilities on the agent desktop. 

 
  Desktop Manager Supervisor – extends the standard capability by 

enabling additional intrusion and monitoring capabilities. 
 

  Desktop Manager DDE & COM – extends the Desktop Manager standard 
capability by enabling integration to external applications and databases. 
Typically used for screen-pop applications. 

 

  Desktop Manager Messaging – extends the interactive capability 

between agents and within the business by facilitating internal 

messaging communication. 
 

  Desktop Manager Directory - extends the Desktop Manager standard 
software module by enabling agents to locate personnel within an 
organization for on-line support or customer query confirmation/support. 

 

  Desktop Manager Outbound – extends the Desktop Manager 
standard software module by enabling basic preview outbound voice 
calls to be placed. Also provides agents access to view scripts used 
to define outbound campaigns. 

 

  Desktop Manager Web Agent – extends the Desktop Manager standard 

module by enabling the use of alternative media including chat and web 

collaboration. 
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  Desktop Manager E-mail Agent – extends the Desktop Manager standard 
module by enabling agents to interact with customers via E-mail. When 
used in conjunction with the Knowledge Base Manager, Auto-email 
response functionality is provided. 

 

  Desktop Manager SMS Agent – extends the Desktop Manager standard 
module by enabling agents to interact with customers via SMS. 

 

  Desktop Manager IP Agent – allows the agent the capability to make 
incoming and outgoing calls via the IP soft client in Desktop Manager 
thereby eliminating the need for agents to have a physical telephone. 

 
  Desktop Manager IP Recording – allows the agent or supervisor the 

capability to record any IP calls from the IP soft client. 
 

BluStar Agent 

 

  BluStar Agent Standard – provides agents access to voice/call related features 

including call control capabilities on the agent desktop. 

 

  BluStar Agent Supervisor – extends the standard capability by enabling additional 

intrusion and monitoring capabilities. 
 

  BluStar Agent Integration – enables integration to external applications and 
databases. Typically used for screen-pop applications. 

 

  BluStar Agent Messaging – extends the interactive capability between agents and 

within the business by facilitating internal messaging communication. 

 

  BluStar Agent Directory - extends the BluStar Agent standard software module 

by enabling agents to locate personnel within an organization for on-line support 

or customer query confirmation/support. 
 

  BluStar Agent  E-mail Agent – extends the BluStar Agent standard module by 
enabling agents to interact with customers via E-mail. When used in conjunction 
with the Knowledge Base Manager, Auto-email response functionality is provided. 

 

  BluStar Agent SMS Agent – extends BluStar Agent standard module by 

enabling agents to interact with customers via SMS. 
 

  BluStar Agent IP Agent – allows the agent the capability to make incoming 
and outgoing calls via the IP soft client in BluStar Agent thereby eliminating 
the need for agents to have a physical telephone. 
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1.1.2 Phone Agent 

 
This agent module is used for mobile agents, that is, Phone Agents that have 
access to only a phone device. Therefore, warehouse staff, security staff or 
agents with mobility, can be incorporated into the contact center. 

 

 

1.2 Management Applications 

 
The modules in this category provide centralized control and 
management of the invested contact center infrastructure. 

 

 

1.2.1 Report Manager 

 
Provides historical statistical reporting and information on all contact center 

activities. 
 

 

1.2.2 Configuration Manager 

 
Provides configuration management and the editing of contact center 
elements such as call flows, rules and guidelines. 

 

 

1.2.3 Information Manager 

 
Provides real time information on all contact center activities. 

 
 

1.2.4 Knowledge Base Manager 

 
Provides an authoring interface towards the knowledge bases. Knowledge 
bases are used with the Web-based self-help application (Virtual Agents) 
and auto E-mail response interaction. 
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1.3 Customer Self-service Applications 

 

 

1.3.1 Script Manager 

 
A fully integrated Interactive Voice Response (IVR) application that extends 
the routing intelligence and capability of Solidus eCare suite. Used to enable 
advanced customer access to database lookups and PIN code verifications, 
the primary use of Script Manager is to provide voice bound customers with 
self-service. Simultaneously, Script Manager is used to accurately identify the 
needs of the customer, prior to the customer being allocated to a Solidus 
eCare agent. 

 

 

1.3.2 Virtual Agent 

 
An interactive Web response application that automates customer self- service. 
The Virtual Agent resides on your website, resolves customer enquiries without 
agent intervention through the use of customized knowledge bases. 

 
The context, nature and operational environment of the contact center shall 
determine the inclusion of the various applications listed above. 

 

 

1.4 Overview of Information Manager 

 
Information Manager provides real time status information about the service 
accesses, service groups, agent groups and agents of the contact center. 

 
See the following summary: 

 
  Configure user preferences on how to view the current contact center 

services and staffing information; 

 

  View real time information on service accesses, service groups, agent 

groups or agents; 

 

  Produce text and real time messages for display on external wall 

displays. 
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1.5 Overview of the Main Window 

 
The main window consists of the title bar, the main menu bar, the 

toolbar, and an application workspace. 

 
Menus on the menu bar, as well as their associated toolbar buttons, will be 
available and operable only when the proper object, from the proper view 
pane, is selected. In the example below, all buttons are enabled for 
illustrative purposes only. 

 
The default main window layout includes the Service Access window, 
Service Group window and Agent Group window. The Alarm Log window 
will be minimized and stays at the bottom of the workspace. 
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1.6 Calculation methods 

The following tables contain information regarding the calculation 

methods for the values found in specific real time windows. 

 

 

 
Service Access Overview Window 
 

Value Calculation Method 
Average handling time for all service 
accesses 

 

(Sum of handling times) / (Sum of calls 
distributed to all services accessed) 

 
 
 
 
 

Service Group Overview Window 
 

Value Calculation Method 

Estimated waiting time Received from Event Service. 

Percentage of busy agents Number of busy agents divided by the total 
number of ready agents. 

Percentage of busy others Number of busy agents who currently 
servicing other service group or non-service 
calls or monitoring a chat session divided by 
the total number of ready agents. 

Percentage of idle agents Number of idle agents divided by the total 
number of ready agents. 

Percentage of partially busy agents Number of partially busy agents divided by 
the total number of ready agents. 

Service level Number of calls answered within specified 
minutes and seconds (service level time) / 
(Sum of Number of calls answered and 
Number of calls abandoned (in ring + queue). 
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Service Group Details Window 
 

Value Calculation Method 
Abandoned rate (Number of abandoned calls) / (Number of 

answered calls + abandoned calls) 
Average handling time (Sum of talk, on-hold and clerical time for all 

answered calls) / Number of calls answered 
Average time abandoned (Sum of queue time + ring time before 

abandoned) / (Number of calls abandoned in 
queue + Number of calls abandoned in ring) 
 

Average wait time (Sum of queue time, callback time, call setup 
time and ring time for all answered calls) / No. 
of calls answered 

Estimated waiting time Received from Event Service 
Service level Number of calls answered within specified 

threshold (service level time) / (Sum of 
Number of calls answered and Number of 
calls abandoned (in ring + queue) + Number 
of calls rejected). 

 
 
 
 
 

Agent Group Overview Window 
 

Value Calculation Method 
Percentage of agents handling non-
service calls 
 

Number of agents busy handling non-service 
calls divided by the total number of logged 
on agents in this agent group 

Percentage of agents handling service 
calls 
 

Number of agents busy handling service 
calls divided by the total number of logged 
on agents in this agent group. 
 

Percentage of not ready agents 
 

Number of agents marked as not ready 
divided by the total number of logged on 
agents in this agent group 
 

Percentage of idle agents 
 

Number of agents not handling a call divided 
by the total number of logged on agents in 
this agent group 
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1.7 Message Data Types 

 
Below is a summary of available data types. 

 

 

Abandoned Rate The ratio of number of abandoned calls over the total 
service calls/sessions within a specified time period. 

Average Handling 
Time 

Average time in minutes and seconds for agents to 
handle service calls/sessions in this service group. 

Average Abandoned 
Time 

Average amount of time in minutes and seconds the call 
was waiting before the call was disconnected. This also 
includes media requests that were cancelled before 
routed to an agent. 

Average Wait Time Average time in minutes and seconds that service 
calls/sessions to this service group are waiting before 
being answered. 

Current Date Today's date. 

Current Skill Choice The current skill choice that has been included for agent 
selection by route manager. 

Current Time Current time. 

Estimated Waiting 
Time 

Indicates the system’s best prediction of how long a 
session will remain in queue for the service group. 

Longest Wait Time Current longest time a caller has been waiting in queue 
for the selected service group. 

Number of Abandoned 
Calls 

Calls that get disconnected before being answered by an 
agent. The reason can be that the caller hangs up. This 
also includes media requests that were cancelled before 
routed to an agent. 

Number of Answered 
Calls 

Calls that are answered by agents serving this service 
group. When handling a media session, when the max 
number of configured media sessions for that agent has 
been reached, this number is included in this value. 

Number of Busy 
Agents 

Agents that are currently occupied with a Service call for 
this group. The agent is Busy when a Service call for this 
group has been presented to the agent, the agent has 
answered the call, the call has been placed on hold or the 
agent is involved in clerical activities after completing the 
call. For agents handling media sessions, when the max 
number of configured media sessions for an agent has 
been reached, that agent is included in this value. 

If the number of Busy Agents is lower than a pre-defined 
threshold, when calls are waiting in queue, this 
information is indicated in red 

Number of Callbacks 
Accepted 
 

Number of callback calls that are accepted by the caller. 

Number of 
Callbacks Failed 

Number of callback failed due to various reasons such as 
invalid callback number, time-out due to no answered, 
time-out due to busy. 

Number of Calls 
Direct In 

The number of calls that came directly to the group. 

Number of Calls 
Overflowed In 

The number of calls entering the group from another 
destination. 
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Number of Calls 
Overflowed Out 

Calls that are overflowed to another destination due to 
different reasons such as either the estimate waiting time 
or the actual waiting time has been exceeded. 

Number of Calls in 
Queue 

Number of calls and media requests that are currently 
waiting in the delayed call queue for this service group. 

This number can trigger an alarm if exceeding a pre-
defined threshold. 

 
Number of Idle 
Agents 

Agents that are able to receive a new Service call. The 
agent is idle and not handling any call/E-
mail/SMS/chat/open media. 

Number of Logged 
On Agents 

Agents that have logged on. 
 

Number of Not 
Ready Agents 

Agents that have been unavailable marked by an agent 
or by the Contact Center system for voice calls and E-
mail/SMS/chat/open media. 

Number of Offered 
Calls 

Calls initiated to the service group or overflowed in from 
another service group. 

Number of Partially Busy 
Agents 

Number of ready agents that are handling a session for 
this group, but can still receive additional sessions for this 
media type. 
 

Number of Ready 
Agents 

Agents that have been available marked. This includes 
agents that are available for either voice or media. If this 
value is lower than a pre-defined threshold, this 
information is indicated with red color. 

Percent of Service 
Level 

The percentage of Service calls that are answered within 
a specified time period. If the Service Level is less than 
the defined threshold as specified for the group, this 
information is indicated in red. 
 

Service Group 
Name 

Name of the service group. 
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2 Using Information Manager 
 

 

2.1 Change Solidus eCare Systems 

 
Note: This option is only available to Host Administrators. 

 
To switch to another Solidus eCare system, you will need to know both the 
Solidus eCare server name you wish to connect to as well as the Web server 
name in order to logon. 

 
1 On the File menu, click the Change System command. The 

Change System dialog box will appear. 
 

2 Select the system you wish to switch to. 
 

3 Click OK. 
 

 

2.2 Save and Open Preferred Window Choices 

 
After you have customized your screens to reflect the window choices and 
arrangements that you will be using the most, you may want to save those 
choices as your preferred windows. Your preferred choices will be displayed 
the next time you launch Information Manager. Note that your Real Time 
windows layout is associated with your Solidus eCare User ID. 

 
The Save Layout As command on the Options menu saves the current 
presentation layout of your windows by saving the window size, position and 
window information in the database. Window information includes your 
specifically selected groups and agents in the order you last specified. 

 
Once you have saved your Real Time windows with the display layout and 
information choices that you prefer, you can open them with this arrangement 
anytime you want by clicking the Layouts command on the Options menu 
and selecting the name of your desired 

layout. However, you cannot use the Layouts command until you have 

saved your preferred windows. 

 
Note: Saving current window layout automatically can also be done if you 

select the Save Layout Changes Automatically check box on the 
Preferences dialog box. 
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2.3 Configure External Display Messaging 

 

 

2.3.1 Overview 

 
External Display Messaging allows you to create and send text messages, 
combined with real time information about the contact center to the Virtual 
Wall Display window, Web Display or to Spectrum display boards. For 
Spectrum boards, messages can be sent to a specific board or all boards that 
are connected to a PC. Boards are connected to a PC through a single serial 
communications port. 

 
Messages and displays are defined through the Wall Display Configuration 
dialog box. The messages defined here may be displayed on the external 
Spectrum boards or the virtual wall display. Most properties for the 
messages are common to both displays such 
as name, time range and text and data segments, certain properties on the 
Messages tab are only for the virtual wall display. There are also certain 
properties that are specific to the Spectrum boards. These properties are 
accessed through the Spectrum Message Configuration dialog box. 

 
 
 
 
 

2.4 Configure General Settings 

 
To display messages on your external wall device or Spectrum board, you 
first need to define messages. Messages are made of segments that contain 
text and data information. 

 
After creating your messages, the next step would be to display the 
messages. For virtual wall displays, you need to define and set attributes 
associated with the rows where the messages will display. 

 

 

2.4.1 Configure Messages 

 
You can manipulate the display of messages through the Wall Display 
Configuration dialog box Messages tab. Use the Add or Delete buttons to 
create or remove a message. Messages are made of text and data segments. 

 
In the Message Information section, you can change the name of the 
message and also indicate if the message is available for display. You can set 
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the Time Range and also set specific display setting associated with a Virtual 
Display and with Spectrum boards, by clicking on the Virtual Display or 
Spectrum tabs. 

 

At the bottom of the Messages tab, you can add or edit a segment to 
construct your message. You can also delete or edit a message from the 
Messages tab. 

 

 
Add a new message 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, in the Messages area, click Add. A default 

message name appears in the Name text box. 
 

3 Edit the message name by clicking in the Name text box and 

entering a desired name. 
 

4   Select Enabled if you wish the message to display. 
 

5   Set a Time Range during which the message will display. 
 

6   Set the display properties on the Virtual Display tab. 
- OR - 

If your display device is a Spectrum board, click the Spectrum tab to set 

the display properties. 
 

7 Add Text and Data segments to the message. If your display device is 
a Spectrum board, you can add up to 64 segments per message. 

 
8   Repeat step 6 to add additional segments to your message. 

 

9 Use the sort buttons to indicate the order you wish your segments to 

display. 
 

10 Click OK. 
 

 
Delete a message 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message you wish to delete from the 

Messages list box. 
 

3   Click Delete. 
 
 

Display/enable a message 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, in the Messages list box, select the 

message you wish to display. 
 

3 In the Message Information section, click Enabled. 
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Edit a message name 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, in the Messages list box, click the name of the 
message you wish to change. Information associated with this message 
appears in the Message Information section. 

 

3 Click in the Name text box and change the message name. The new 

name will appear in the Messages list box. 
 
 
 
 
 

Hide a message 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, in the Messages list box, select the 

message you wish to hide. 
 

3 Clear the Enabled checkbox. The message will be hidden from view. 

 
Note: Hidden messages will appear grayed in the Messages list box. 
You can still add segments to this message as well as assign this 
message to a row or Spectrum display. These messages however, will 
not appear on the display device. 

 
 
 
 
 

Set the display color 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, click the Virtual Display tab. 
 

3 Click '...' next to the object you wish to assign a color to. The Color 

dialog box displays. 
 

4 Select a color. 
 

5 Click OK. The selected color appears next to the object. 
 
 
 
 
 
 

Set the display mode 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, click the Virtual Display tab. 
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3 Select the display mode from the Mode drop-down list. 

These options describe what text effect is applied as text is 

displayed on the Virtual Wall Display. 

 
Please refer to the Virtual Display tab of the Wall Display Configuration dialog box for a 
complete listing of these options. 

 

 
Set the display speed 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, click the Virtual Display tab. 
 

3 Use the Speed slider to set the speed that text will display. 
 

 
Set the time a message displays 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, in the Message Information section, use the 
spin controls in the Time Range section, to set when the message is to 
start by setting a value for From. 

 

3 Use the spin controls to set when the message will stop by setting a value 

for To. 
 
 

2.4.2 Configure segments 

 

 
Add a data segment 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
 

3 Click Add Data. The Add Data dialog box appears. 
 

4 Select the type of data and the group from the drop-down lists. 
 

5 Click OK. The new data segment will appear in the Segments list box. 
 
 
 
 
 

Add a text segment 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
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3 Click Add Text. The Add Text dialog box appears. 
 

4 In the Message Text field, enter the text you wish to appear for this 

segment. 
 

5 Click OK. The new text segment will appear in the Segments list box. 
 

 
 
 
 

Delete a segment 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
 

3 Select the data or text segment you wish to delete. 
 

4 Click Delete. 
 
 

Edit a data segment 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
 

3 Select the data segment you wish to modify. 
 

4 Click Edit. The Add Data dialog box appears. 
 

5 Change the type of data and the group from the drop-down lists. 
 

6 Click OK. The changed data segment will appear in the Segments list 

box. 
 
 
 
 
 

Edit text segment 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
 

3 Select the text segment you wish to edit. 
 

4 Click Edit. The Add Text dialog box appears. 
 

5 In the Message Text field, change the text. 
 

6 Click OK. The modified text segment will appear in the Segments 

list box. 
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Set the order for segments to appear 
 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, select the message that the segment is 

associated with. 
 

3 Select the segment in the segments list box located at the bottom of the 

dialog box. 

 
4 Click or to rearrange the segment in the list. The segment 

will display in the order listed, with the segment on top first on a message 
and the segment on bottom last on a message. 

 
 
 

2.5 Configure rows 

 

 

2.5.1 Overview 

 
Each enabled row on a wall display is shown as a separate line in the Virtual 
Wall Display window. If you have already defined messages, configuring row 
information involves the following general steps: 

 
1 Creating a row. 

 
2 Enabling the row. 

 
3 Assigning messages to the row. 

 
4 Ordering the row on the display. 

 
 
 
 
 

2.5.2 Open the Virtual Display tab 

 
1 On the Options menu, click Virtual Wall Display. 

 
2 The Wall Display Configuration dialog box will appear. 

 
3 Click on the Virtual Display tab. 
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2.5.3 Assign a message to a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, select the desired row. 
 

3 Select a message from the Available list. You can select more than 

one message at a time. 
 

4 Click  to move the selected messages to the Selected list box. 
You can also double-click a message to move it to the 

 

Selected list. 

 
Note: If you select a message that is disabled, this message will not 

display though it is assigned to the row. 
 

 

2.5.4 Create a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, click Add. A default row name 

appears in the Name text box. 
 

3 Edit the row name by clicking in the Name text box and entering a 

desired name. 
 

4 Select Enabled if you wish the row to display. 
 

5 Select the font to use for this row by clicking on the font button. The current 

font name and size displays on this button. 
 

6 Assign Messages to this row. 
 

7 Sort the messages to indicate the order messages will display. 
 

8 Click OK. 
 

 

2.5.5 Delete a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, in the Rows list box, select the row you 

wish to remove. 
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3 Click Delete. The row and its associated parameters are deleted. 
 
 
 
 
 

2.5.6 Display a row on a  display device 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, in the Rows list box, select the row you 

wish to display. 
 

3 In the Row Information section, click Enabled. 
 

 
 

2.5.7 Edit a row name 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, click the name of the row you wish to 
change. Information associated with this row appears in the Row 
Information section. 

 

3 Click in the Name text box and change the row name. The new name 

will appear in the Rows list box. 
 
 
 
 
 

2.5.8 Enable a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, in the Rows list box, select the row you 
wish to display. 

 
3 Select Enabled located in the Row Information section beside the 

Name text box. 
 
 
 
 

2.5.9 Hide a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 
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dialog box. 
 

2 From the Virtual Display tab, in the Rows list box, select the row you 

wish to hide. 
 

3 Clear the Enabled checkbox. The row will be hidden from view. 

 
Note: Hidden rows will appear grayed in the Rows list box. You can 
still add messages to a disabled row though the row will not appear on 
the display device. 

 

 

2.5.10 Remove a message from a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, select the desired row. 
 

3 Select a message from the Selected list in the Messages section. 

You can select more than one message at a time. 
 

4 Click  to move the selected messages to the Available list box. 

You can also double-click a message to move it to the Available list. 
 

 
 
 
 

2.5.11 Reorder rows 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, select the row you wish to move. 
 

3 Click Move Up or Move Down to move the row to the correct 

position. 
 

4 Repeat steps 2 - 3 until your rows are positioned correctly. 
 
 
 
 
 

2.5.12 Order messages on a row 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
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2 From the Virtual Display tab, select the row with the desired 

message. 
 

3 Select a message in the Selected list box. 
 

4 Click  or  to rearrange the messages in the Selected list. 
The messages will display in the order listed, with the message on top 
first and the message on bottom last. 

 
 
 
 
 

2.5.13 Set the order for rows to appear 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, select a row in the Rows list box. 
 
 

3 Click Move Up or Move Down to rearrange the row in the Rows list. 
The Rows will display in the order listed, with the row on top first and 
the row on bottom last. 

 
 
 
 
 

2.5.14 Specify a row font 

 
1 Open the Virtual Display tab of the Wall Display Configuration 

dialog box. 
 

2 From the Virtual Display tab, select the row you wish to configure from 

the Rows list box. 
 

3 In the Row Information section, click the Font button. The Font 

dialog box appears. 
 

4 Select the font settings. 
 

5 Click OK. The Font name and Size will appear on the Font button. 
 
 
 
 
 

2.6 Configure Spectrum boards 
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2.6.1 Overview Spectrum Boards 

 
Spectrum display boards are connected to a PC through a single serial 
communications port (COM port). Spectrum board properties and messages 
are configured from the Spectrum Tab of the Wall Display Configuration 
dialog box. General message and display properties are defined through the 
Spectrum tab located on the Messages tab of the Wall Display 
Configuration dialog box. These properties include display mode, display 
position and display colors, and are specific to Spectrum boards. 

 
Note: If a COM port and Spectrum boards have been defined, the messages 

will begin displaying automatically when Information Manager is 
started. When Information Manager is closed, the messages will be 
removed from all defined boards. The display of messages will also 
start and stop when the Wall Display Configuration dialog box is 
opened and closed. This will occur even if there are no changes to the 
defined messages or boards. 

 
Below are limitations and calculations specific to Spectrum display 
boards. 

 
 

Limitations 
 

These limitations are only applied when a message is sent to a 
Spectrum board. 

 

  The maximum number of messages displayed on a board is 32. 
 

  The maximum number of data segments per message is 8. 
 

  The maximum number of data segments per board is 64. 
 

  The maximum length of a message is 80 characters. This includes text and 
data segments. If text will extend past the max length it will be truncated. If 
a data segment will extend past the max, it will be omitted. The space in 
between segments is included in the max length. 

 

 
Segment Length Calculation 

 
The length of data segments is determined by the maximum size of the data 
they may contain. For example, a data segment for a number of agents may 
contain a maximum value of 9999. The length of this segment will be 
considered 4 even if the segment is currently displaying the value 1. The 
lengths for data segments are as follows: 

 

  Current Time: 8 
 

  Current Date: 10 
 

  Service Group Name: 20 
 

  Waiting Times: 8 
 

  Agent Counts: 4 
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  Average Times: 5 
 

  Call Counts: 5 
 

  Skill Choice: 1 
 

  Percentages: 4 
 
 
 
 
 
 

 

2.6.2 Open the Spectrum tab 

 
1 On the Options menu, click Virtual Wall Display. 

 

2 The Wall Display Configuration dialog box will appear. 
 

3 Click on the Spectrum tab. 
 
 
 
 
 

2.6.3 Pre-configure the boards 

 

 
Pre-configure the boards 

 
Prior to generating any messages, make sure that all Spectrum wall 
displays for the Solidus eCare have been configured. The following events 
are required for the configuration of Spectrum wall displays: 

 
1 Use the Remote Control units that have been shipped with the wall 

displays to configure a unique physical address for each of the wall 
displays. This address will be stored internally within each wall display. 

 
2 Use the Spectrum tab of the Wall Display Configuration dialog box to 

specify the COM port that the wall boards are connected to and add the 
wall boards that will be used by Solidus eCare mapping each defined 
board with the physical address stored within the board. 

 
 
 
 
 
 

 
Configure the physical address of a wall display using the remote control 

 
1 Make sure that the wall board is properly plugged in. 

 

2 Press the PROG key. PROG TXT FILE A will appear on the wall board. 
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3 Press the BACK key until SET ADDRESS appears. 

 
4 Press the ADV key. SERIAL ADDRESS = 00 will appear. 

 
5 Assign the address by pressing the corresponding number keys. 

For example: if the address for the wall board is 01, press 0 and 1 on the 

remote control. 
 

6 Press the RUN key. 
 

7 Press the PROG key. 
 

 
 

Specify the COM port and define the boards 
 

1 Open the Spectrum tab. 
 

2 From the Spectrum tab, select the COM port that the boards are 

connected to by selecting a value in the Port drop-down list. 
 

3 Select the Baud Rate for communicating with the boards. In most cases 

9600 should be selected. 
 

4 Add a new board by clicking Add. 
 

5 Change the name if necessary in the Name field 
 

6 Select a Model. 
 

7 Enter the hex value that defines the board in the Address text field. 
This should be the same address configured using the remote 
control. 

 

8 Enter some text into the Test field and press Test. The text should display 

on the wall board. 
 

9 Repeat steps 5 – 9 for all boards connected to the PC. 
 

 
Verify a connection to the Spectrum board 

 
1 Open the Spectrum tab. 

 
2 From the Spectrum tab, enter a test message in the Test field. 

 
3 Click Test. This option is not available if the board Port setting has not 

been set. If the test message appears in the mode that you have selected 
(in the Mode drop-down list on the Spectrum tab located on the 
Messages tab of the Wall Display Configuration dialog box) on the wall 
display(s) that is connected to the communication port specified in the 
Communication Port list, connection is successful. If the test message 
does not appear on the wall display(s), check the connection. 

 
4 Click OK. The test message will be removed from the wall display. 
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2.7 Message configurations 

 

 

2.7.1 Add a display 

 
1 Open the Spectrum tab. 

 

2 From the Spectrum tab, click Add. A generic display name will 

appear in the Name field. 
 

3 Optionally change the Name to a desired name. 
 

4 Complete the settings in the Spectrum Display Information area. 
 

5 Click OK. 
 
 
 
 
 

2.7.2 Delete a display 

 
1 Open the Spectrum tab. 

 

2 From the Spectrum tab, in the Spectrum Display list box, select the 

display you wish to remove. 
 

3 Click Delete. A dialog box will appear asking you to confirm that you 

want to delete the selected display. 
 

4 Click OK. The selected display will be removed from the Spectrum 

Display list. 
 
 
 
 
 

2.7.3 Displaying a message 

 
1 Open the Spectrum tab. 

 
2 From the Spectrum tab, if you have more than one display device, select 

the desired Spectrum board from the Spectrum Displays list. 
 

3 Select one or more Messages from the Available list box. 

 
Note: Messages are configured from the Messages tab. 

 

4 Click  to move the selected messages to the Selected list box.  
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You can also double-click a message to move it to the Selected list. 
 

5 Click  and  to order the Messages in the Selected list box. 
 

6 Set display parameters and display colors from the Spectrum tab 
located on the Wall Display Configuration Messages tab. 

 

7 Click OK. The messages in the Selected list box will appear on the 
Spectrum board when the Virtual Wall Display Configuration dialog box 
is closed. 

 
 
 
 
 

2.7.4 Removing a message 

 
1 Open the Spectrum tab. 

 
2 From the Spectrum tab, select the desired Spectrum Display. 

 
3 Select one or more messages from the Selected list box. 

 

4 Click  to move the selected messages to the Available list box 
and therefore off the display. 

 
5 Click OK. The messages in the Selected list box will appear on the 

Spectrum board when the Wall Display Configuration dialog box is 
closed. 

 
 
 
 
 

2.7.5 Set text colors 

 
1 Open the Wall Display Configuration dialog box. 

 
2 Click the Messages tab. 

 
3 Click the Spectrum tab. 

 
4 Select colors for text, data and alarms that will appear on the 

Spectrum board. 
 

5 Click OK. 
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2.7.6 Spectrum - set order of messages to appear 

 

1 Open the Spectrum tab of the Wall Display Configuration dialog box. 
 

2 From the Spectrum tab, select the desired Spectrum Display. 
 

3 Select a message in the Selected list box. 

 
4 Click to rearrange the messages in the Selected list. 

The messages will display in the order listed, with the message on top 

first and the message on bottom last. 
 

 
 
 
 

2.7.7 Specify a display mode and text position 

 
1 Open the Wall Display Configuration dialog box. 

 
2 Click the Messages tab. 

 
3 Click the Spectrum tab. 

 

4 Select a Display Mode and Position to indicate how the message will 

display. 

Please refer to the Spectrum tab on the Messages tab of the Wall 
Display Configuration dialog box for a complete list of options. 

 
5 Click OK. 

 

 

2.8 Configure Virtual Wall Display Settings 

 

 

2.8.1 Configure Virtual Wall Display 

 
Messages and displays are defined through the Wall Display Configuration 
dialog box. Though most properties for messages are common to both the 
Virtual Wall Display and Spectrum boards, certain properties only apply to the 
Virtual Wall Display. These settings are found on the Virtual Display tab and 
include: 

 

  Virtual Wall Display Color 
 

  Virtual Wall Display Mode 
 

  Virtual Wall Display Speed 
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2.8.2 Set the display color 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, click the Virtual Display tab. 
 

3 Click '...' next to the object you wish to assign a color to. The Color dialog 

box displays. 
 

4 Select a color. 
 

5 Click OK. The selected color appears next to the object. 
 
 
 
 
 

2.8.3 Set the display mode 

 

1 Open the Messages tab of the Wall Display Configuration dialog box. 
 

2 On the Messages tab, click the Virtual Display tab. 
 

3 Select the display mode from the Mode drop-down list. 

These options describe what text effect is applied as text is 

displayed on the Virtual Wall Display. 

 
Please refer to the Virtual Display tab of the Wall Display Configuration dialog box for a 
complete listing of these options. 

 

 

2.8.4 Set the display speed 

 
1 Open the Messages tab of the Wall Display Configuration dialog box. 

 
2 On the Messages tab, click the Virtual Display tab. 

 
3 Use the Speed slider to set the speed that text will display. 

 

 

2.9 Web Wall Display 
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Messages sent to a Wall Display can also be sent to a Web Display or 
a Wall Display Gadget. By configuring a web server port using the Wall 
Display Configuration dialogue box, Information Manger accepts http 
connections on the specified port. 

 
The Web Wall display can be customized by using a cascading stylesheet. To 
customize, copy the \Sample Code\IM Samples\DefaultWebRoot from the 
DVD to [InstallDir]\Solidus eCare\Applications\bin and rename it to webroot. 
Information Manager loads the files from the webroot directory at startup. 

 

An example of a customized stylesheet is located in the 
\Sample Code\IM Samples\CustomizedWebRoot folder on the DVD. Copy 
the file WebDisplay.css to the webroot folder to view the customization. 

 
The address to the server is http://[hostname/localhost]:[configured port] 

 
Use Internet Explorer and enter the URL to start the Web Display. 
Example: http://localhost:8181 

 
It is also possible to use or customize a Windows sidebar gadget containing 
Wall Display information. The installation files for the gadget are located in 
Sample Code\IM Samples\WindowsSidebarGadget. See readme.txt located in 
the WindowsSidebarGadget folder for more information on how to install the 
SolidusIM.gadget file. 

 

 

2.9.1 Add Namespace Reservation Rights 

 
If the user has not logged in as an administrator on the PC where the 
Information Manager client that hosts the Web Wall Display is running, then 
namespace reservation rights need to be added to the account used. 

 
For Windows Server 2008 R2 and Windows 7, the namespace 
reservation rights are granted by using the following command: 

 
netsh http add urlacl url=http://+:8181/ 

user=DOMAIN\user 

 

where 8181 is the port the user has opted to use for the web server, 

DOMAIN is the windows domain you're logged on to and user is the user 

account that one wishes to grant the rights to. 

 
To grant namespace reservation rights when using Windows XP, use the 

httpcfg utility included in the Support Tools for WinXP. 

 
Download the Support Tools from the following link: 
http://www.microsoft.com/download/en/details.aspx?displayLang=en&i 
d=18546 

 
Use the following procedure: 

 
1.  Run the command: httpcfg set urlacl /u 

http://+:8181/ /a D:(A;;GX;;;WD) 

 

2.  Restart the computer 

http://localhost:8181/
http://www.microsoft.com/download/en/details.aspx?displayLang=en&amp;i
http://www.microsoft.com/download/en/details.aspx?displayLang=en&amp;i
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For instructions on how to grant namespace reservation rights for other 
operating system than those mentioned above, use the following link: 
http://msdn.microsoft.com/en-us/library/ms733768.aspx 

 
 

2.10 Define Custom Summary Groups 

 

 

2.10.1 Add a custom summary group 

 
1 Open the Custom Summary Groups dialog box. 

 
2 Click Add in the Custom Summary Groups area. If there is more than 

one media type defined on your system, the New Custom Summary 
dialog box appears. Otherwise, skip to step 5. 

 
3 Select the media type associated with this group. 

 
4 Click OK. 

 

5 A default Summary Group name appears in the Name field. Click in the 

Name field to edit this name. 
 

6 Select an available service group from the Available list box. You can 

select more than one name at a time. 
 

7 Assign your selection to the summary group by clicking . The 
selected service groups are moved to the Selected list box. These groups 
will appear as members of your custom summary group. 

 

 

2.10.2 Delete a group from a custom summary group 

 
1 Open the Custom Summary Groups dialog box. 

 
2 Select the desired Summary Group in the Custom Summary Groups 

area. Information specific to the selected group appears in the Custom 
Summary Group Information area. 

 

3 Select the service group you wish to remove from the Selected list box. 

You can select more than one name at a time. 
 

4 Remove the selected group by clicking  . The selected groups are 
moved to the Available list box. These groups will no longer appear as 
members of your custom summary group. 

 
 

http://msdn.microsoft.com/en-us/library/ms733768.aspx
http://msdn.microsoft.com/en-us/library/ms733768.aspx
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2.10.3 Delete a custom summary group 

 
1 Open the Custom Summary Groups dialog box. 

 
2 Select the Summary Group you wish to delete in the Custom 

Summary Groups area. 
 

3 Click Delete. 
 
 
 
 
 

2.10.4 Add service groups to a custom summary group 

 
1 Open the Custom Summary Groups dialog box. 

 
2 Select the desired Summary Group in the Custom Summary 

Groups area. 
 

3 Select an available service group from the Available list box. You can 

select more than one name at a time. 
 

4 Assign your selection to the summary group by clicking . The 
selected service groups are moved to the Selected list box. These groups 
will appear as members of your custom summary group. 

 
 
 
 
 

2.11 Define User Preferences 

 

 

2.11.1 Defining User Preferences 

 
Define user-dependent preferences by opening the Preferences dialog box, 
and filling in all the necessary information in the General, 
Overview Windows, Alarms and Alarm Log areas. Since preferences 
selected in this dialog box affect the way that the system will interact with 
each individual user, it is important that such preferences be assigned in the 
beginning. 
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2.11.2 Open the Preferences dialog box 

 
From the Options menu, select Preferences. The Preferences dialog box will 
appear. 

 

 

2.11.3 Automatically save layout changes 

 
This option automatically saves the current display layout when you exit 
Information Manager. 

 
 

2.11.4 Save Filter Selection 

 
This option automatically saves the filters from the Service Group Agent and 
Agent Group Agent windows as part of the layout. 

 

2.11.5 Set number of Agent Group rows to display 

 
This setting applies to the Agent Group Overview Window. You can 
indicate from one to three rows. 

 

2.11.6 Set number of Service Group rows to display 

 
This setting applies to the Service Group Overview – Graphical 

Window. You can indicate from one to three rows. 
 

2.11.7 Set the overview windows chart style 

 
Chart style applies to Service Group Overview – Graphical and 
Agent Group Overview Windows.  The options include 3D, Flat, and Gradient 

 
 

2.12 Alarm Settings 

 

 

2.12.1 Enable a flashing alarm 

 
1 Open the Preferences dialog box. 
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2 From the Preferences dialog box, select the Flash Alarm Icon option to 

cause a flashing alarm icon to appear in the toolbar when an alarm 
occurs. This icon will continue to flash until the alarm is cleared in the 
Alarm Log. 

 
 

2.12.2 Disable a flashing alarm 

 
1 Open the Preferences dialog box. 

 
2 From the Preferences dialog box, clear the Flash Alarm Icon 

check box to disable the flashing alarm option. 
 
 
 
 
 

2.12.3 Display an Agent Group name for Agent Group alarms 

 
1 Open the Preferences dialog box. 

 
2 From the Preferences dialog box, clear the Display Agent Name for 

Agent Group Alarms check box to cause an agent group name to 
appear in the Alarm Log when an agent group alarm occurs. 

 
 
 
 

2.12.4 Display an Agent Name for Agent Group alarms 

 
1 Open the Preferences dialog box. 

 

2 From the Preferences dialog box, select the Display Agent Name for 

Agent Group Alarms option to cause an agent name to 

appear in the Alarm Log when an agent group alarm occurs. This option 

is not available if Agent Privacy is enabled. 
 
 
 
 
 

2.12.5 Display Agent Name for Service Group alarms 

 
1 Open the Preferences dialog box. 

 
2 From the Preferences dialog box, select the Display Agent Name for 

Service Group Alarms option to cause an agent name to appear in the 
Alarm Log when a service group alarm occurs. This option is not 
available if Agent Privacy is enabled. 
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2.12.6 Display a Service Group name for Service Group alarms 

 
1 Open the Preferences dialog box. 

 
2 From the Preferences dialog box, clear the Display Agent Name for 

Service Group Alarms check box to cause a service group name to 
appear in the Alarm Log when a service group alarm occurs. 

 
 
 
 

2.13 Perform Alarm Log Functions 

 

 

2.13.1 Open the Alarm Log window 

 
1 On the Real Time menu, click Alarm Log. 

 
- OR - 

 

Click   on the toolbar. 
 

2 The Alarm Log window will appear. 
 

 

2.13.2 Acknowledge an alarm message 

 
1 Open the Alarm Log window. 

 
2 In the Alarm Log window, select an alarm message. You can select 

more than one message at a time. The message(s) will be highlighted. 
 

3 Click . The message will remain in the window but will no longer 
appear red. 

 

 

2.13.3 Clear an alarm message 

 
1 Open the Alarm Log window. 

 

2 In the Alarm Log window, select an alarm message. You can select more 

than one message at a time. The message will be 

highlighted. 
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3 Click . The message will no longer appear in the Alarm Log 
window. 

 

 
 

2.13.4 Print an Alarm log 

 
1 Open the Alarm Log window. 

 

2 Click . The entire alarm log will be printed; however, messages that 
have been cleared will not be printed. 

 
 
 
 

2.14 Perform Layout functions 

 

 

2.14.1 Display a custom layout 

 
1 On the Options menu, click Layouts. 

 
- OR - 

 

Click   on the toolbar. 

 
The Layouts dialog box will appear. 

 
2 From the Layouts list box, select the layout you wish to display. 

The highlighted layout indicates the current layout. 
 

3 Click OK. The main window will refresh to display the windows 

associated with the selected layout. 
 
 
 
 
 

2.14.2 Save a new layout 

 
1 On the Options menu, click Save Layout As. The Save Layout 

As dialog box will appear. 
 

2 In the Name text box, enter a layout name. 
 

3 Click OK. 



32/1553-LXA 119 154 Uen E2 2013-02-14 37 

 
 

 
 
 
 
 

2.14.3 Delete a layout 

 
1 On the Options menu, click Layouts. 

 
- OR - 

 

Click on the toolbar. 

 
The Layouts dialog box will appear. 

 
2 From the Layouts list box, select the layout you wish to delete. 

 
3 Click Delete. The selected layout will be removed from the 

Layouts list box. 

 
Note: The layout that is highlighted will become the current layout. 

 
 
 
 
 
 

 

2.14.4 Save the current layout 

 
On the Options menu, click Save Current Layout. 

 
- OR - 

 

Click   on the toolbar. 

 
The displayed real time windows and positions will be saved to the current 
layout. 

 
 
 
 
 

2.15 Display Real Time Information 

 

 

2.15.1 Service Accesses 
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Display Service Accesses 

 
The Service Access Overview window displays the current status of all the 
service accesses that you can access. From the Service Access Overview 
window, you can: 

 

  View all the service accesses that you are allowed to access; 

 

  View the details of each service access. Such details include 

information such as the number of 

current/direct/overflowed in/handled/overflowed out/abandoned calls 

and the Average Handling Time; 
 

  View the summary for all the service accesses that you are allowed to 

access; 
 

    Sort the service accesses. 
 

 
Open the Service Access Overview window 

 
On the Real Time menu, click Service Access Overview. 

 
- OR - 

 

Click   on the toolbar. 

 
The Service Access Overview window will appear. 

 

 

2.15.2 Service Group 

 

 
Display Service Group 

 
The Service Group Overview window displays the current status of either 
all the service groups or specified service groups that you can access. 
There are two different display formats for Overviews: 

 

  Graphical - displays the current service group status in the form of vertical 

stacked bar graphs 

 

  Table - which displays detailed performance and status information for a 

specified service group 
 

    From the Service Groups window, you can: 
 

    Sort the service groups you want to display, 

 

  Select a particular service group to view the agents currently 

serving that group, 
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    View the group details for a selected service group. 

 
Note: If Agent Privacy is activated, you will not be able to view any 

information regarding agents. 
 

 
Open the Service Group Overview - Graphical window 

 
On the Real Time menu, click Service Group Overview then Graph. 

 
- OR - 

 

Click on the toolbar. 

 
The Service Group Overview - Graphical window displays. 

 

 
Open Service Group Overview - Table window 

 
On the Real Time menu, click Service Group Overview then Table. 

 
- OR - 

 

Click   on the toolbar. 

 
The Service Group Overview - Table window displays. 

 

 
Open the Service Group Selection dialog box 

 
1 Open the Service Group Overview window for Graphical, or 

Table. 
 

2 Click  on the window toolbar. 

 
- OR - 

 
Right mouse click on a Service Group name or right click within the bar 

graph area, and select Sort on the shortcut menu. 

 
The Service Group Selection dialog box appears. 

 
 
 
 

Change the display order of service groups in the Service Group windows 
 

1 Open the Service Group Selection dialog box. 

 

2 In the Service Group Selection dialog box, use the  and  

buttons to change the sort order of the Service Groups. 
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3 Select a Service Group in the Displayed list and use the  and 

 buttons to change the display order of the Service Groups. 
 

4 Click OK. 
 

 

Display Service Groups associated with a Summary group 

 
From a Service Group Overview window (Graphical, or Table), double- click on 
a <Summary> group bar graph 

 
- OR - 

 

Select a Summary Group name from the drop-down list and click . 

 
-OR- 

 
Right mouse click on a summary group bar graph and select Details 
from the shortcut menu. 

 
A Service Group Overview window (Graphical or Table) appears with the 
selected summary group name display in <> on the title bar and the service 
groups associated with the selected summary group visible. 

 

 
Display Group Details 

 
From a Service Group Overview window (Graphical, or Table), select a non-
summary service group name from the drop-down list and click 

 
. 

 
-OR- 

 
Right mouse click on a non-summary group bar graph and select 
Details from the shortcut menu. 

 
A Service Group Details window appears with the selected service group 
name displayed in [ ] on the title bar. 

 

 
Display Service Group Agents 

 
From a Service Group Overview window (Graphical, or Table), double- click on 
a non-summary service group bar graph 

 
- OR - 

Select a non-summary service group name from the drop-down list and click 

. 

 
-OR- 
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Right mouse click on a non-summary group bar graph and select 
Agents from the shortcut menu. 

 

A Service Group Agents window appears with the selected service group 
name display in [ ] on the title bar. 

 
 
 
 
 

Hide a service group from a Service Group Overview window 
 

1 Open the Service Group Selection dialog box. 
 

2 In the Service Group Selection dialog box, select the service group you 
wish to hide from the Displayed list box. You can select more than one 
service group. 

 

3 Click  to move the selected service groups to the Hidden list box. 
These service groups will no longer appear in the Service Group 
Overview windows. 

 
4 Click OK. 

 
 
 
 
 

2.15.3 Agent Group 

 

 
Display Agent Group 

 
The Agent Group window displays: 

 

  Current status of the agent groups that you can access, in the form of 

vertical stacked bar graphs. 

 

  Name of the group, number of available agents and number of logged 

on agents for each group above each graph. 

 

  Percentage of logged on agents that are busy handling an service call, 

handling another call or not handling any call. 

 
From the Agent Group Overview window you can constantly monitor 
specific agent groups and access the current status of agents in a particular 
group. 

 
Note: If Agent Privacy is activated, you will not be able to view any 

information regarding agents. 
 

 
Open the Agent Group Overview window 

 
On the Real Time menu, click Agent Group Overview. 
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- OR - 

 

Click   on the toolbar. 

 
The Agent Group Overview window will appear. 

 
 
 
 
 

Open the Agent Group Selection dialog box 
 

1 Open the Agent Group Overview window. 
 

2 Click  on the window toolbar. 

 
- OR - 

 
Right mouse click on an Agent Group name or right click within the bar 
graph area, and select Sort on the shortcut menu. 

 
3 The Service Agent Selection dialog box appears. 

 
 
 
 
 

Change the display order of agent groups 
 

1 Open the Service Agent Selection dialog box. 
 

2 In the Service Agent Selection dialog box, use the  and  

buttons to change the sort order of the Agent Groups. 
 

3 Select an Agent Group in the Displayed list and use the  

and  buttons to change the display order of the Agent Groups. 
 

4 Click OK. 
 
 
 
 
 

Display Agent Group Agents 

 
From an Agent Group Overview window, double-click on a non- 
summary agent group bar graph 

 
- OR - 

 

 
 

Select a non-summary agent group name from the drop-down list and click 
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. 

 
-OR- 

 
Right mouse click on a non-summary group bar graph and select 
Agents from the shortcut menu. 

 
An Agent Group Agents window appears with the selected agent group 
name display in [ ] on the title bar. 

 
 
 
 

Hide an Agent Group from the Agent Group Overview window 
 

1 Open the Service Agent Selection dialog box. 
 

2 In the Service Agent Selection dialog box, select the agent group you 

wish to hide from the Displayed list box. You can select more than one 

agent group. 
 

3 Click  to move the selected agent groups to the Hidden list box. 
These agent groups will no longer appear in the Agent Group Overview 
window. 

 
4 Click OK. 
 

2.15.4 Campaigns 

 

 
Display Campaign Overview 

 
The Campaign Overview window displays: 

 

  List of all running campaigns 

 

  Name of the campaign, service group, total customers, number of 

customers called, number of customers not called, successful calls and 

unsuccessful calls. 

 

 
Open the Agent Group Overview window 

 
On the Real Time menu, click Campaign Overview. 

 

- OR - 

 

Click   on the toolbar. 

 
The Campaign Overview window will appear. 
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Display Campaign Details 

 
The Campaign Details window displays: 

 

  Campaign configuration information:  Campaign name, service group, 

status, and schedule 

 

  Statistics for the campaign as a number and percentage:  total 

customers, number called, number not called, number successful, 

number unsuccessful, unsuccessful calls with attempts remaining, 

unsuccessful calls with no attempts remaining, number of failed calls 

due to busy, number of failed calls due to no answer, number of 

failed calls due to other reasons 
 
 
 

Open the Campaign Details Window 

 
From the Campaign Overview window, double-click on a campaign 

 
-OR- 

 
Right mouse click on a campaign and select Campaign Details 
 
From a Service Group Overview Window, right mouse click on a 
non-summary campaign group bar graph, select Campaign Details then the name of the 
campaign from the shortcut menu. 

 
A Campaign Details window appears with the selected campaign name 
display in [ ] on the title bar. 
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